
BEA WorkshopTM Product Family
Release Notes

10.2 Maintenance Pack 1 (10.2 MP1) 

May 2009



BEA Workshop for WebLogic Release Notes, 10.2 Maintenance Pack 1 (10.2 MP1)

Copyright © 2009 Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure 
and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you 
may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any 
part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law 
for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, 
please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. 
Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. 
Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal 
Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, 
and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the 
extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial 
Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not developed or intended 
for use in any inherently dangerous applications, including applications which may create a risk of personal injury. If you use 
this software in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and 
other measures to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for any damages 
caused by use of this software in dangerous applications.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective 
owners.

This software and documentation may provide access to or information on content, products, and services from third parties. 
Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to 
third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or 
damages incurred due to your access to or use of third-party content, products, or services.



BEA Workshop 10.1 Release Notes iii

Contents

What's New in Workshop Version 10.2? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

Improved reliability and performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

Tuxedo Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

WorkSpace Studio Launcher . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

Adobe Flex Builder 2 and Flex Charting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2

Location of Supported Platform Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2

Location of Workshop Source Code  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2

Required Patches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2

Known Limitations for Workshop 10.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

Resolved Problems for Workshop for WebLogic Version 10.2 MP1 . . . . . . . . . . . . . . . . .14



iv BEA Workshop 10.2 Release Notes



BEA Workshop 10.2 Release Notes 1

BEA Workshop Version 10.2 Release 
Notes

This document contains information on the following subjects:

What's New in Workshop Version 10.2?

Location of Supported Platform Information

Location of Supported Platform Information

Location of Workshop Source Code

Known Limitations for Workshop 10.2

Resolved Problems for Workshop for WebLogic Version 10.2 MP1

What's New in Workshop Version 10.2?
Improved reliability and performance
This release of BEA Workshop provides numerous issues fixes and improved performance to enhance the 
development experience. 

Tuxedo Control 
Workshop now supports the Tuxedo Control, which allows your applications to connect to Tuxedo services.

WorkSpace Studio Launcher 
Workshop is now integrated with the WorkSpace Studio launcher at 
BEA_HOME/workSpaceStudio_1.1/workSpaceStudio/workSpaceStudio.exe.

../guide/controls/system/tuxctrl/overview/wlwint.html
../workspaceFAQ.html
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Adobe Flex Builder 2 and Flex Charting
Workshop Studio bundles Adobe Flex Builder 2 and Flex Charting as a third party add-on (for Windows 
only). 

Features of Adobe Flex Builder 2 include: 

Visual designers and layout tools for Flex and Action Script 

Powerful Flex coding and code navigation tools 

Integrated Flex compiler and debugger 
To install Adobe Flex Builder 2 into Workshop Studio see Installing Adobe Flex 2. 

Note that Adobe Flex Builder 2 and Flex Charting are only supported on Windows. 

Location of Supported Platform Information
For more information on platform support, including hardware and software requirements, see the 
Supported Platforms web site.

Location of Workshop Source Code
To comply with the Eclipse Public License, BEA has made source code for derived work available for 
download at

http://www.oracle.com/technology/community/welcome-bea/index.html

Required Patches
When you install WebLogic Portal 10.2, required patches are installed automatically. If you uninstall any of 
these patches and need to reinstall them, use the information in the table below in conjunction with the Smart 
Update utility to reinstall and apply the patches. For detailed information on using Smart Update, see 
Installing Patches and Maintenance Packs Using Smart Update on e-docs. 

Patch ID Passcode

LBTB 8CJVM75F

5XK2 IIR34WPM 

 PJM6 (includes G9NJ, JRUI, 5BBF, 13HH, 89U9) 6TCBRW3H 

http://e-docs.bea.com/platform/suppconfigs/configs102/102_over/overview.html
../../../common/smartupdate/guide/index.html
https://submit-codesamples.projects.dev2dev.bea.com/servlets/Scarab?id=S372
../guide/ideuserguide/install/installAdobeFlex.html
http://www.bea.com/flex/
https://submit-codesamples.projects.dev2dev.bea.com/servlets/Scarab?id=S372
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Known Limitations for Workshop 10.2
Table 1 lists the known limitations found in Workshop for WebLogic.

Table 1  Known Limitations in BEA Workshop Version 10.2

Problem ID Description

CR282777 The first time you run Project > Clean after importing a project, Workshop for WebLogic may 
not clean all of the files from the .apt_src directory

When a user imports a project including build directories such as .apt_src, all files in that 
directory might not get removed the first time a clean is performed. This only happens the first 
time, subsequent cleans correctly handle the generated directories.

Platform: All

Workaround: Manually delete the files in the .apt_src directory when performing a clean the 
first time after import. Once deleted, the new files that go into that directory are correctly handled 
by the clean action.

CR287585 When a web service or other artifact is in a web project that is part of more than one EAR, the 
Run on Server can produce the wrong URL.

Using the Run on Server action on artifacts in a web project that is associated with multiple EARs 
in the workspace can launch the browser to the incorrect URL. That is, it will use the URL 
associated with the last EAR with which is was associated.

Platforms: All

Workaround: 
To workaround this issue, you can either 
a) close the EAR that is not to be used for the launch, 
b) remove the web project from the EAR that is not used for the launch, or 
c) manually update the URL in the browser to hit the correct EAR.

CR293197 Lost JVMTI events (especially breakpoints) when debugging with JRockit

When debugging with the JRockit JVM you may experience performance problems and missed 
breakpoints.

Platforms: All

Workaround: Update to JRockit 5.0 R27.1 or later.
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CR294199 Invocation of buffered Control methods will fail at runtime if deployed (via the IDE) to a server 
with more than one JMS Server

The IDE will auto-deploy required Workshop libraries when deploying an application.   The use 
of @MessageBuffer on Control methods creates a dependency on application-scoped JMS 
resources in the weblogic-controls library. If the weblogic-controls library is deployed (by the 
IDE) to a server with more than one JMS server, the library will deploy, but the 
application-scoped JMS resources will not be available. This is because the IDE depends on 
default sub-module targeting, and default sub-module targeting relies on the target containing 
exactly one JMS Server. A message similar to the following warns that there is an issue with the 
deployment:

<The JMS module named "WlwRuntimeAppScopedJMS" inside 
application "testLibWebApp" does not have a sub-deployment stanza
named "WlwRuntimeAppScopedJMS". Without such a stanza no entities
inside the module will be deployed, since the sub deployments
inside of the sub-deployment stanza named
"WlwRuntimeAppScopedJMS" control where JMS entities inside this
module are targeted.>

Note that even though there is a warning message, the library is deployed to the server. This 
means that applications that are dependent on the library will also successfully deploy. However, 
invocation of buffered Control methods will fail at runtime with a message similar to the 
following:

"Failed to invoke end componentFailed to invoke methodMessage
buffering is not available - either the buffering MDB did not
deploy or we are in a standalone WAR"

Note that this situation is most likely to occur when using domains that were not created with 
support for "Workshop for Weblogic Platform.

Platforms: All

Workaround: 
Manually deploy the library using the weblogic.Deployer command. The form of the command 
is:
java weblogic.Deployer 
  -username weblogic 
  -password weblogic 
  -adminurl t3://localhost:7001 
  -deploy 
  -name weblogic-controls-10.0
  -source %WL_HOME%/common/deployable-libraries/weblogic-controls-10.0.ear
  -targets cgServer
  -submoduletargets cgJMSServer@WlwRuntimeAppScopedJMS@WseeJmsServer

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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 -library -libspecver 10.0 
  -libimplver 10.0
Where: 
- WseeJmsServer is the name of the JMS Server to host the application-scoped 
destinations.
- targets is the development server

The command updates the library definition in config.xml.  Therefore it only needs to be run 
once.

CR301661 Buffered methods on ServiceControl may fail over JMS protocol

Buffered operations on a ServiceControl must be void. However the Message Exchange Pattern 
(MEP) in the underlying WSDL can be either request/response (with an empty response), or 
oneway (a request with no response).

In the case of a request/response MEP over JMS, the presence of @MessageBuffer will cause 
the request to deadlock and eventually timeout. The following warning message will generally 
be produced:

Potential blocking operation
{http://someNamespace}someOperation: a synchronous
request/response invocation within a transaction using the JMS
transport can cause deadlocks. Please refer to WebLogic
documentation for details.

The resulting error message will include text similar to:

javax.xml.rpc.soap.SOAPFaultException: Failed to receive message 
java.io.IOException: Request timed out

Note: this only occurs when the transport protocol for the request is JMS.

Platforms: All

Workaround: If you can influence the design of the target JWS, having the JWS operation 
annotated with @Oneway will direct that the underlying MEP be oneway, and will avoid this 
situation. If you can not influence the design of the target JWS, then the workaround is to add 
the TransactionAttribute annotation to the ServiceControl operation:

@MessageBuffer
@TransactionAttribute(TransactionAttributeType.NOT_SUPPORTED)
public void voidMethod();

Note that the presence of the @TransactionAttribute will not change the transactional behavior 
of actions that occur within the calling application.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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CR304008 Servlet 2.5 Implementation In WebLogic Server 10.0 Can Break 9.2 Beehive Applications

Description: An issue may surface when a 9.2 Beehive application is deployed on WebLogic 
Server 10.0. The symptom with this scenario is a java.lang.IllegalStateException being thrown. 
The underlying issue is with the javax.servlet.ServletException which changed from Servlet 2.4 
to Servlet 2.5.

Platforms: WebLogic Server 10.0 or higher

Workaround: Upgrade the application to use Beehive 10.0 libraries (which work with either 
Servlet 2.4 or Servlet 2.5). If the 9.2 application cannot be compiled in 10.0, then manually 
updating the deployment descriptors in the 9.2 application EAR to use the 10.0 Beehive libraries 
will resolve this issue. For example:

For each .war in the 9.2 .ear, modify the following section of the web-inf/weblogic.xml:

<wls:library-ref>
<wls:library-name>beehive-netui-1.0</wls:library-name>
<wls:specification-version>1.0</wls:specification-version>
<wls:implementation-version>1.0</wls:implementation-version>

</wls:library-ref>

to look like:

<wls:library-ref>
<wls:library-name>beehive-netui-1.0.1-10.0</wls:library-name>
<wls:specification-version>1.0</wls:specification-version>
<wls:implementation-version>1.0.1.1</wls:implementation-version>

</wls:library-ref>

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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CR304502 Users who upgrade an 8.x application to a 9.x/10.x application may experience issues when 
making multiple method calls to a JDBC control from a single page flow method

Due to a change in transaction scope from page flows which has been documented in 

http://e-docs.bea.com/workshop/docs92/ws_platform/upgrading/conChangesDuringUpgrade.ht
ml

See the section labeled: 'Controls are Not Automatically Run Within the Scope of a Transaction'

Users who upgrade an 8.x application to a 9.x/10.x application may experience issues when 
making multiple method calls to a JDBC control from a single page flow method. The crux of 
the issue is that when the first call is made to the JDBC control a new transaction is created by 
our transaction interceptor. When that call returns the transaction is either committed or rolled 
back. 

On the next call to the JDBC control a new transaction is created, but the JDBC connection being 
used by the control cannot be used in another transaction (it has been associated as a resource of 
the first transaction).

The behavior in 8.x page flows was for the JDBC control to release its JDBC connection after 
each method invocation. The transaction scope for a control method being invoked from a page 
flow was to start a transaction at the beginning of the control method invocation, and end the 
transaction on the return of the method. If the control rolled back the transaction, all operations 
performed within that transaction would be rolled back as well. 

Platforms: All
Workaround: There are several workarounds available:

1) If you do not want to use transactions (they were implicit in
8.x) the transaction interceptor annotations (inserted by the upgrader) can be removed from the 
control methods.

2) If you want to use transactions, create a JTA transaction in the page flow method and either 
commit or rollback once the calls to the JDBC control are completed.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description


http://e-docs.bea.com/workshop/docs92/ws_platform/upgrading/conChangesDuringUpgrade.html
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CR308749 Duplicate simple class names are not supported for web service controls with callbacks

When multiple web service controls, with callbacks, have identical class names (ignoring 
package name) an error will occur in jwsc. This error will appear in the publish step in the ide, 
during the usable step in exported ant scripts, or when exporting an ear file from the ide. In 
previous versions of Workshop the exported ant scripts would incorrectly report that the 
assemble step had succeeded even though this condition was present. This was because the ant 
script did not attempt to run jwsc on garnered java files.

Platforms: All
Workaround: When using web service controls (SerivceControl) with callbacks make sure that 
each control file has a unique un-qualified class name. Differing the package name is not 
sufficient.

CR313306 Service control generation can produce incorrect callback method names

Service control generation based on WSDL callbacks named with underscores and numbers can 
result in incorrect callback method names. This will occur if a lower case letter follows an 
underscore or number.

For example, the following WSDL callback names:

a_b
a4b

will result in the generation of the following callback method names:

a_B
a4B

Note that the first character after a number or underscore has been capitalized.

When the method is invoked, the following error will result.

javax.xml.rpc.JAXRPCException: SOAPFaultException - FaultCode
[{http://schemas.xmlsoap.org/soap/envelope/}Client] FaultString
[Failed to get operation name from the incoming request] 

Platforms: 10.x

Workaround: Avoid callback method names with a lower case letter following an underscore 
or number.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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CR326326 Workshop startup.jar cannot be used to run in headless mode on Linux unless an additional 
system property is defined

The startup.jar provided with Workshop cannot be used to run in headless mode on Linux, unless 
the following system property is set to true:

m7.disable.swt.init

Platforms: Workshop 10.1

Workaround: Launch workshop in headless mode with the system property m7.disable.swt.init 
set to true. Note that the DISPLAY system property must not be set for this workaround to 
succeed.

CR326466 Issue with Hibernate JPA deployment on Weblogic Server 10.0

Hibernate JPA projects created in Workshop 10.1 or imported from Workshop Studio 3.x fail to 
deploy on Weblogic Server 10.0. The below workaround will help Hibernate JPA projects 
deploy but redeployment will require a server restart

Platforms: Workshop 10.1 and later

Workaround: For EAR Projects - Modify weblogic-application.xml and add the following

<prefer-application-packages>

<package-name>antlr.*</package-name>

<package-name>org.apache.commons.*</package-name>

<package-name>org.apache.oro.*</package-name>

<package-name>oracle.*</package-name>

</prefer-application-packages>

For Web Applications - Add the web project to an EAR and then modify 
weblogic-application.xml as described above.

Note: Redeployment of the project requires a server restart.

CR327602 After renaming project, old project is not undeployed from the server

If you rename a project that belongs to an EAR, the previous project name will not be undeployed 
from WebLogic Server. 

Platforms: Workshop 10.1
Workaround: To remove the project from the server, undeploy and redeploy the application 
from WebLogic Server.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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CR327849 Problems deploying EJB project upgraded using command line upgrader

You may encounter problems deploying an EJB project that has been upgraded using the 
command line upgrade tool upgradeStarter.

Platforms: Workshop 10.1
Workaround: Upgrade the project using the IDE instead of the command line tool. To upgrade 
using the Workshop IDE.

CR328406 Incomplete AppXRay database may be produced after upgrade

After upgrade from Workshop version 8.1.x to 10.2 or migration from 9.2 through 10.0 to 10.2 
the initial build of the upgraded application may produce an incomplete AppXRay database for 
web projects that have the AppXRay feature enabled. In this case the user may notice that the 
App Xaminer view does not show all dependencies correctly. 

Platforms: Workshop 8.1 and later

Workaround: To correct this situation clean and rebuild the workspace (by selecting Project > 
Clean).

CR334542 ExceptionInInitializerError deploying web service on WebLogic Server 9.2

When deploying a web service to pre-MP1 versions of WebLogic Server 9.2, you may encounter 
a ExceptionInitializerError.

Platforms: Workshop 10.2 and WebLogic Server 9.2

Workaround: Implement one of the following solutions:

(1) Upgrade your WebLogic Server 9.2 installation to 9.2 MP1 or higher.

(2) Or add the following flag to both the workSpaceStudio.ini file and WebLogic Server’s start 
script for the VM.

-Dcom.sun.xml.namespace.QName.useCompatibleSerialVersionUID=1.0

CR336597 Web application deployment descriptor graphical editor doesn't support <resource-ref> 
elements

Workshop’s graphical editor for deployment descriptors does not support <resource-ref> 
elements. The Deployment Descriptor Elements tree view (located above the source editor) 
and the Outline view do not support adding or editing <resource-ref> elements.

Platforms: All

Workaround: Use source view to add and edit <resource-ref> elements.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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CR340273 Filter dispatcher warnings from JSF webapp deploy

The version of MyFaces bundled with Workshop logs warnings to the WebLogic Server console 
due to a bug in the MyFaces web.xml parser. This bug is tracked here:

  http://issues.apache.org/jira/browse/MYFACES-1415

The warnings are harmless and result in no loss of functionality.

Platforms: All

Workaround: These warnings can be ignored.

CR342837 Some Workshop text fields do not support Ctrl+V paste

In the presence of the WebLogic Portal Eclipse plugins, some of the Workshop text fields do not 
support the Ctrl+V paste operation. 

Platforms: All

Workaround: Manually type text into these text fields.

CR342995 Linux: Workshop JSP design view does not support drag and drop

On Linux, the Workshop JSP design view does not support drag and drop from the Design 
Palette.

Platform: Linux

Workaround: Drag-and-drop from the Design Palette onto the source view.

CR344306 Minimal support for JSP XML syntax

The Workshop JSP designer does not support JSP's XML syntax and gives warnings when 
parsing XML JSPs. For example, use of an entity reference “&amp;” for the character "&" will 
report a warning in the Problems view that deployment is prevented.

Platforms: All

Workaround: These warnings can be ignored: JSP XML syntax does not hinder deployment of 
the application.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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CR350342 Projects upgraded from Workshop Studio 3.3 may require manual upgrade of Kodo license

The Kodo license bundled with Workshop Studio 3.3 release has expired, so older applications 
which have the license file at <Project_Home>/src/license.bea need a manual upgrade.

Platforms: Applies to JPA/Kodo applications upgraded from Workshop Studio 3.3 to Workshop 
10.1 and later.

Workaround:

Create a new project that supports JPA/Kodo. For details, see 
http://edocs.bea.com/wlw/docs101/guide/ormworkbench/conAddingEJB3Support.html

Copy the license.bea file from the new project into the original project’s src folder.

CR355189 Licensing concerns when Workshop Studio 10.2 and Workshop for WebLogic 10.2 are installed 
in same the BEA Home

If a user has both Workshop for WebLogic 10.2 and Workshop Studio 10.2 installed in the same 
BEA_HOME and either the Workshop Studio trial or full license expires, all Workshop 
functionality (including both Workshop Studio and Workshop for WebLogic) will be 
unavailable.

Platforms: Workshop for Weblogic 10.2 and Workshop Studio 10.2.

Workaround: Uninstall Workshop Studio 10.2 by performing the following: 

Run uninstall, deselecting all components except Workshop Studio in the uninstall wizard. 
Launch the product again. The Workshop for WebLogic license will be used and Workshop for 
WebLogic functionality returns.

CR356110 Workshop closes console when the server fails to start

When WebLogic Server fails to start in Workshop, the Console view may be closed making it 
difficult to monitor the errors associated with the failure to start.

Platforms: Workshop 10.2

Workaround: Follow the procedure below:
1. In the Server view, double-click the server instance to open the Server Overview.
2. In the section Startup and Deployment, uncheck Launch WebLogic server in Eclipse 
Console.
3. Start WebLogic Server using the start up script located at 
<domain_home>\bin\startWebLogic.cmd|.sh.
4. To view the errors associated with the start up failure consult the command shell console 
output.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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CR359446 Run time server points to the previous version 

After upgrading a Workshop for WebLogic Platform application from 10.2 to 10.2 MP1, the run 
time server points to the previous version instead of the latest version. 

Platforms: Windows 

Workaround: In Workshop, select Window > Preferences > Server > Installed Runtime. Select 
the appropriate runtime.

CR362046 WorkSpace Studio About Box may stop displaying plugin and configuration details after a BEA 
Product is removed from the BEA Home directory

After uninstalling a BEA product from your BEA Home directory in which you have other 
products installed, the Plugin Details and Configuration Details buttons in the WorkSpace Studio 
IDE about box (Help > About BEA WorkSpace Studio) may stop working. This is due to the 
fact that under some circumstances empty plugin directories may still be present after the plugins 
are removed and the IDE expects to locate, but can not find, plugin details in those directories.

Platforms: WorkSpace Studio 1.1

Workaround: Launch WorkSpace Studio with -clean.

CR376598 Error when attempting to launch WorkSpace Studio

When attempting to launch WorkSpace Studio, the following error is returned: 
/bea/jdk150_11/jre/bin/java: symbol lookup error: 
/bea/tools/eclipse_pkgs/1.1/eclipse_3.2.2/eclipse/configuration/or
g.eclipse.osgi/bundles/104/1/.cp/libswt-mozilla-gtk-3236.so: 
undefined symbol: _ZN4nsID5ParseEPKc

Platforms: Linux

Workaround: Add the following line to the eclipse.ini file which points to the 32 bit 
version of the xulrunner library:
-Dorg.eclipse.swt.browser.XULRunnerPath=<path_to_32bit_xulrunner_l
ib>

On RHEL5, for example, the path would be /usr/lib/xulrunner-1.9.

Table 1  Known Limitations in BEA Workshop Version 10.2 (Continued)

Problem ID Description
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Resolved Problems for Workshop for WebLogic Version 
10.2 MP1

Table 2 lists the resolved problems in Workshop for WebLogic.

Table 2  Resolved Problems for Workshop for WebLogic Version 10.2 MP1

Problem ID Description

CR360415 A PageFlow used to invoke a JDBCControl method via a custom control on the 
onDestroy() method. When a call was made to another PageFlow, the 
onDestroy() method used to be invoked. However, the JDBCConnection was not 
returned back to the pool. This caused a connection leak.

This problem has been resolved.

CR370270 NetUI formatNumber tag used to give incorrect results for large span values. Large 
decimal values such as 999999999999999999.97 used to be printed as 
1,000,000,000,000,000,000.

This problem has been resolved.

CR370542 Service Control timeout value was not set for the connection timeout.

This problem has been resolved.

CR368565 NetUI compat anchor tag used to return NullPointerException when there was 
no URL rewriter with the context. 

This problem has been resolved.

CR368431 Dynamic checkbox was not working correctly when using double quote characters in 
the <netui-compat:checkBoxGroup> tag. The value accepted used to terminate 
at the first double quote character.

This problem has been resolved.

CR368814 Boxes in the netui:checkBoxGroup tag were not checked with the correct default 
value attribute.

This problem has been resolved.

CR370297 The .jspf files used to be validated as individual files and not with the .jsp file 
that included the .jspf file.

This problem has been resolved.
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CR368812 The <netui:errors/> tag was not compatible with 10.2 page flow framework and 
used to raise a JspException. 

This problem has been resolved.

CR364251 Webservice-from-WSDL scenario was not working on Linux platform. 

This problem has been resolved.

CR375589 The reinitialization mechanism of handlers was not passed on to the member handlers 
causing NullPointerException in few cases. 

This problem has been resolved.

CR370714 When using page flows within the application in a clustered setup with four managed 
servers, NullPointerException used to be returned.

This problem has been resolved.

CR360879 Using transport guarantee NONE used to cause https requests to be redirected to https 
requests instead of being redirected to http requests. 

This problem has been resolved.

CR370394 There were few issues with netui:checkBoxGroup and 
netui-compat:anchor tags.

This problem has been resolved.

Table 2  Resolved Problems for Workshop for WebLogic Version 10.2 MP1
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